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MassCEC’s Work Spans Four Main Areas of Climate Impact for MA

Climatetech Innovation & Accelerating Large Scale Deployment: Clean Energy & Climate
Investment Decarbonization Offshore Wind Workforce Development

We're helping new climate- We're tackling barriers We're building a cutting- We're partnering with schools
focused businesses grow faster to widespread use of clean edge offshore wind and other education partners to
tErOUgh (_jlreCt support and energy and climate industry, marshaling world-class build the skilled and diverse

y creating an ecosystem teChnOIOgy in bUIIdIngSI ports, a robust supply chain and workforce essential to achieving

MassCEC has invested in $650M in the MA clean energy economy and has attracted more than $2.5B in private & federal funds



Offshore Wind Programs

PLANNING AND ANALYSIS - Support technical studies and
projects to collect, analyze and interpret physical and biological
data, establish baseline site conditions, and support permitting.
Promote forums and opportunities for robust stakeholder
engagement to inform planning and siting, project-specific reviews
and progression, and state /regional policy and program planning.

OFFSHORE WIND WORKS - Develop and sustain a qualified, well-
trained, safe, and diverse OSW workforce to plan, build, operate
and maintain regional offshore wind facilities through grants and
technical assistance. Convene and facilitate offshore wind
workforce development practitioners to exchange information and
best practices.

OFFSHORE WIND BUSINESS READY (SUPPLY CHAIN) - Foster the
growth of offshore wind business in the Commonwealth by
supporting the localization of the global industry and expanding
participation of MA-based manufacturers, suppliers, and service
providers in the offshore wind supply chain through technical
assistance, tax incentives, and grants.

Reduce project risk, increase market confidence, and support the economic development and workforce
opportunities of the offshore wind sector

PORTS, INFRASTRUCTURE, AND HARBOR ACCESS - Manage
investments in redevelopment of priority OSW port facilities and
infrastructure and seek additional funding. Ensure the utility of MA
ports for OSW activities through trainings (e.g., marine harbor
pilots), coordination with port managers and users, and supporting
availability of real-time met-ocean conditions.

OFFSHORE WIND SCIENCE AND RESEARCH - Cultivate capacity
for and directly support applied research, science, and analysis
projects and initiatives for the long-term planning, deployment,
and/or operations of offshore wind in the southern New England
and Gulf of Maine lease areas.

OCEAN RENEWABLE ENERGY & CLIMATETECH INNOVATION -
Collaborate with partners to support entrepreneurs and early-stage
companies in technology and IP development and
commercialization. Advance development of ORE testing and
validation sites (dockside, nearshore, offshore).




OSW Workforce Development Strategy

# 1 &

RESEARCH AND ANALYSIS ENGAGE INVEST
Conduct targeted research Engage directly with OSW Invest in and leverage
and analysis to inform industry to ensure programs resources for essential, high-
workforce development and efforts align with their need programs to meet
initiatives needs needs and fill gaps
(35 (93,

SUPPORT CONVENE

Proactively support Convene, support, and

programs and initiatives that facilitate practitioners and

build an OSW workforce that stakeholders to share

is diverse, equitable, information, ideas,

inclusive, and just challenges, and best practices



Offshore Wind Workforce Opportunities

Planning and development

e Activities that precede construction, including site characterization,
research, engineering, and permitting

Manufacturing and Assembling

e The ability to produce components of offshore wind turbines and
AR TS R’ associated infrastructure domestically is ramping up in the
=Rk | _ Commonwealth.
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Construction and installation

e Pre-assembly, installation, and commissioning, with a large roles for
skilled trades, organized labor, engineers, project managers, and
individuals with maritime and water transportation expertise

Operations and maintenance

e Regular inspection of turbines, foundations, cables, and substations,
and process of making necessary repairs or replacements




Workforce Demand

2023 MASSCEC CLEAN ENERGY WORKFORCE NEEDS 2024 VINEYARD WIND 1 IMPACT ON JOBS AND
ASSESSMENT ECONOMIC OUTPUT
Industry Growth Projections Data from Project under Construction
* Roughly 2,000 jobs in MA by 2030 e Over 3,000 Workers employed on VW1,
e 2,200 - 3,500 depending on equating to 1,610 FTEs.
development scenario * Nearly 1,400 Union Workers have
* Most jobs created will be in the been employed on the project
manufacturing sector * Nearly 1,800 Nonunion Workers
have been employed on the project
 MA residents received 78% of total labor
High Growth Occupations income.
* Electricians

* Misc. Assemblers and Fabricators 2018 & 2021 OFFSHORE WIND WORKFORCE TRAINING &
* Metal Fabricators and Fitters DEVELOPMENT IN MASSACHUSETTS REPORT
e  Misc. Metal and Plastic Workers

Misc. Installation, Maintenance and 2022 ASSESSMENT OF CURRENT OFFSHORE WIND

Repair Workers WORKS PORTFOLIO OF INVESTMENTS




OSW Workforce Development Investments

» Introductory offshore wind courses and programs - Programs to introduce the workforce (and supply chain)
opportunities of OSW industry and include curricula and activities for K-12 students, CTE, college students, professionals

» Health and safety training programs - Programs to provide essential, industry-recognized health, safety, and maritime
training, include Global Wind Organisation’s (GWO) programs, medical fitness certifications, and maritime/US Coast
Guard certifications and licensures. + Studies

» Trades programs - Programs specifically oriented to support the roles of organized labor, maritime workers, and other
skilled trades for offshore wind.

» Technical training programs - Programs to train workers for both construction and installation and O&M scopes,
including GWO, skilled trades training and apprenticeships, offshore wind power technician certificates, and associates
degrees in engineering and technology.

» Undergraduate and graduate programs — OSW specific educational and extracurricular programs and curricula at 4-year
degree and graduate institutions, focusing on engineering, project development, and other professional services.

» Training Infrastructure — Programs to purchase or build critical training infrastructure in Massachusetts, including
training facilities, virtual simulators, and specialized equipment.

» Access to Opportunity - Increase participation of Priority Groups in existing offshore wind workforce programs, Reduce
barriers for individuals interested in pursuing offshore wind job opportunities & provide offshore wind industry exposure
and/or career guidance and counseling on offshore wind career pathways for students and job seekers in Priority Groups




Community of Practice

Quarterly meetings are being held remotely and in-person
for all OSWW grantees and select invitees.

Cop meetings are a place for practitioners to share,
engage, and partner with other organizations.

Topics being covered:
Workforce demand
Industry and regulatory trends
Strategies for engagement with target populations
Incorporating DEIJ into programming

Recruitment best practices




Previous Rounds of OSWW Grants

$18.4 MILLION

In total awards made
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https://www.masscec.com/program/offshore-wind-workforce-grants

OSWW Round 7




Workforce Development Programming

AWARDS UP TO $200,000

Workforce Development and Training Project
» Applicants may propose to establish or expand an existing workforce
development or training program. Applicants can propose to build
capacity to conduct training, fund members to receive industry specific
training, and/or create an introductory pathways program for offshore
wind.
Access to Opportunity Project
» Applicants may propose a project that aims to help mitigate, reduce, or
eliminate existing barriers to entry (see Section V) in the offshore wind
industry for members of Priority Group(s) or provide targeted exposure,
career guidance, support, and/or counseling to individuals in the
identified Priority Group(s) pursuing a pathway into the offshore wind
industry.




i PORT WORKFORCE

Focus Areas &

This solicitation seeks specifically to

. SKILLED TRADES & WORKER SAFETY
advance projects related to these areas

CAREER PATHWAYS & AWARENESS

L




Workforce Training Infrastructure

AWARDS UP TO $750,000

Applicants may propose a project to construct, purchase, expand, or
upgrade workforce- or training-related equipment, technology, and/or
facilities to better meet the needs of the offshore wind industry and a
specific workforce training program. Infrastructure can support
physical or virtual training.

MassCEC grant funding is not available for purchase of land, existing
buildings, or other physical infrastructure existing at the proposed
project site.




Award Amounts and Cost Share

» $2,500,000 Total Funding Available

» Award Amounts
» For Workforce Development Programming: Up to S INGH
$200,000
» For Workforce Training Infrastructure: Up to $750,000 . =)

» Cost Share Amounts 3
» 100% cost-share (1:1 match) of award amount for
private entities
» 25% cost-share of award amount for all other
proposals

-
h 3.



Priority Groups

INDIVIDUALS RESIDING IN ENVIRONMENTAL JUSTICE
NEIGHBORHOODS OR LOW-INCOME COMMUNITIES

An EJ Neighborhood has one or more of the following four
criteria:

» Annual median household income not more than 65% of the
statewide annual median;

» Minorities comprise 40% or more of the population;

» 25% or more of households lack English language
proficiency;

» 25% or more are minorities and the annual median
household income is 150% or less of the statewide median.

MEMBERS OF FEDERALLY RECOGNIZED OR STATE
ACKNOWLEDGED TRIBES

MEMBERS OF UNDERREPRESENTED COMMUNITIES IN
THE CLEAN ENERGY WORKFORCE

CURRENT OR FORMER WORKERS FROM THE FOSSIL
FUEL INDUSTRY

DEFINITION & MAP OF
EJ NEIGHBORHOODS




Project Design

PARTNERSHIPS GEOGRAPHIC LOCATION
* Partnerships with industry representatives or * Strive not to limit programs to only those in
training providers can bolster your proposal by certain regions. Consider the needs of
demonstrating expertise and qualifications of individuals across the state when looking at
the Applicant team. potential barriers.
DIVERSITY, EQUITY, AND INCLUSION ADDRESSING BARRIERS
* DEIlJ elements are encouraged, and proposals * Applicants are encouraged to design programs
can benefit from identifying a Priority Group and that mitigate barriers. Examples of barrier
working to address the barriers that that group reductions may include outreach plans that
may have to participating in the program. address language barriers, lack of digital access,
work readiness or soft skill training, or training
stipends.



Selection Criteria

PROPOSALS WILL BE SCORED AND RANKED BASED ON:

Program Summary and Scope

» Does the proposed project demonstrate understanding of the skills and knowledge necessary for OSW occupations and does it respond to high priority
needs identified in the Solicitation?

Team Experience and Qualifications

» Does the Applicant team have experience delivering high quality work and measured results in related projects?

Work Plan

» Does the proposed project have a clear strategy to complete the project and do the proposed schedule, milestones, and deliverables seem appropriate
and achievable?

Commitment to DEIJ and/or Priority Groups

» Does the application demonstrate a genuine and proactive commitment to DEIJ, both internally in their organizations and in any external programming?
Budget

» Does the proposal include a sufficiently detailed budget, a cost-effective solution, and identification of cost share sources.
Value Demonstration

» What is the overall value proposition of the proposal when compared with other applicants’ proposals and taking into account the broader workforce
ecosystem in Massachusetts and the offshore wind industry.



Application Materials

REQUIRED ATTACHMENTS

» Attachment C: Authorized Representative Signature and Acceptance Form
» Attachment D: Application Form

» Attachment E: Sample Agreement

OPTIONAL ATTACHMENTS

» Letters of Support
» SDO Self-Assessment Results

» DEIlJ Materials

SUBMISSION REQUIREMENTS

» All materials submitted by email to offshorewind@masscec.com by 5:00PM on indicated due date

» Include “2025 Offshore Wind Workforce Solicitation Application” in the subject line

» Responses should be descriptive, but concise


mailto:offshorewind@masscec.com

Timeline

Release of Solicitation February 10, 2025
» Webinar will be recorded and available publicly Informational Webinar February 25, 2025
» Questions must be received by March 31 via email to ,
offshorewind@masscec.com ! Q&A Period Ends March 31, 2025
> Answers will be posted on the Solicitation page on Answers posted by Ongoing
MassCEC’s website MassCEC
» Dates are subject to change at MassCEC’s discretion Proposals Due April 7, 2025 by 5:00 pm
» For planning purposes, Applicants should use October 1, o
2025 as an estimated start date. Notification of Award May 2025
Contracting Process Summer/Fall 2025


mailto:offshorewind@masscec.com

Facilitating Partnerships

MassCEC would like to help facilitate partnerships RESPOND IN CHAT WITH:

between organizations in the offshore wind workforce

. » Organization Name
training and development space.

» Organization Type
» Non-profit, training organization, private company,
If you are interested in forming a partnership, we are educational institution, etc.
starting a puinFIy-hostgd spreadshget wher.e > Contact Name
interested parties can find contact information for

other interested organizations. » Contact Email

» Target sector for partnership

OR EMAIL TO: OFFSHOREWIND@MASSCEC.COM



Q&A

Please submit questions in writing to:
offshorewind@masscec.com

Answers will be posted to the Solicitation
page as questions come in, so check back
periodically




Frequently Asked Questions

CAN AN ORGANIZATION APPLY FOR BOTH A WORKFORCE
PROGRAMMING GRANT AND A SEPARATE INFRASTRUCTURE

GRANT?

Organizations are limited to receiving one grant as
the lead applicant under this grant opportunity.

IS AN ORGANIZATION ALLOWED TO BE THE LEAD ON ONE
APPLICATION AND A SUBCONTRACTOR OR PARTNER ON
ANOTHER?

Yes.

WHAT IS THE ALLOWABLE INDIRECT/OVERHEAD FOR MASSCEC
SUBMISSIONS?

MassCEC does not have a strict limit on allowable
indirect/overhead, however we are accustomed to
seeing rates less than 30%.



Thank you!

Lauren Farnsworth, Senior Program Manager
LFarnsworth@masscec.com

Jeremy Belknap, Program Coordinator
JBelknap@masscec.com



mailto:LFarnsworth@masscec.com
mailto:JBelknap@masscec.com

Appendix




Offshore Wind Market and Pipeline

»State goals and activities

* Current legislative target of 5.6 GW, procured by June 2027
* Vineyard Wind 1 project in construction, 804 MW
* Current procurement in process:

o Led by DOER in consultation with the EDCs

o SouthCoast Wind = 1,087 MW (+ 200 MW for RI)

o Avangrid (New England Wind 1) = 791 MW

« Gulf of Maine auction in 2024: 4 leases; 2 companies

»Regional Pipeline
* South Fork Wind complete:
132 MW, 12 turbines, PPA w/ LIPA

* Revolution Wind offshore construction underway:
704MW, 65 turbines, PPAs w/ CT and Rl

e Sunrise Wind commencing onshore construction:
924 MW, 84 turbines, PPA with NY
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